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SECTION 1  ö  WORKING WITH YOUR FIRST SPREADSHEET 

What will I learn in this section? 

Screen Elements 

ScreenTips, Ribbon Tabs and QAT Customizing 

Excel 2013/2016 Help 
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WORKING WITH YOUR FIRST SPREADSHEET 

About Microsoft Excel 2013/2016  

Creating basic spreadsheets in todayôs computer world is easy. Microsoft Excel 2013/2016 is a simple 

program that allows you to write, modify, save and print spreadsheets. As you explore Excel, you will 

learn about many of the features that make creating your spreadsheet fun and easy.  

Working with Microsoft Excel 2013/2016 

Click the  Start   button in Windows 10 and type Excel in the search box. 

   

Or Windows 7 click the Start button and type Excel in the Start Search box. 
After a few seconds the menu will appear. 

 

Click the  Excel  2013  or Excel 2016  Desktop app menu at the top. 

 

About Screen Elements 

Screen elements are consistent in all Microsoft Office applications. Therefore, once you learn how to use 

the screen elements in one application, you will be able to apply your knowledge in all Microsoft 

applications. On the next page the screenshot identifies the location of each screen element on the ribbon. 

The table following it defines each element. 

For the rest of the book you will use the ribbon configuration shown in this screenshot. The default (the 

way your computer is first setup) is with the Quick Access Toolbar (QAT) at the top over the Home tab. 

You can change this setting, so the Quick Access Toolbar is under the ribbon. This is a personal choice 

and has no effect on functionality. Generally, most individuals like the QAT below the ribbon. 
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Customizing Microsoft Excel 

Do the following steps to make the change needed to place the Quick Access Toolbar (QAT) below the 

ribbon. In all of Microsoft applications you will find the QAT. The menu for the QAT can be access by 

clicking on the More  button on the right end of the tool bar. You will find the more button in different 

places in all the Microsoft applications. 

1. Click the  More  button next to the  Quick Access Toolbar   right above 

the Home tab. (See screenshot below.) 

Your screen should look like this in 2013: 

   

2. Click the  Show Below the Ribbon menu. 

  

3. Click the  More  button again and click Open menu to add to your QAT.   

Your screen should look like this: 

 

In Excel 2016, it is in 

the same location, but 

the coloring is different. 
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Working with Microsoft Excel 2013 or Excel 2016 Ribbon 

 
 

You can hide the ribbon to add additional screen space, by a simple right-click on any tab and select 

Collapse the Ribbon.  

 
 

To have the ribbon return, right-click any tab and click Collapse the Ribbon.   

 

The ribbon can be collapsed or expanded by press the key combination:  [CTRL  + F1] 

This will toggle the ribbon to hide or unhide based on its current state.  

1. Right-click the  Home tab.  

 

2. From the short cut menu, click on the  Collapse t he Ribbon  menu item.  

Your screen should look like this: 

 

Notice this allows you to see a few more rows on your spread sheet while working. 

Tip : You can 

Double-click the 

active tab or press 

[CTRL + F1] to 

collapse or expand 

the ribbon. 
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3. Right-click the   Home tab and click the  Collapse the Ribbon   menu 

again.   

 

This will unhide the ribbon.  
 

Your screen should look like this: (Your ribbon has returned.) 

 

Main Screen Elements 

On the next page, you will see a layout of the main parts of your screen. Review this page from time to 

time to help you remember what things are called. By knowing the names of objects on your screen you 

will be able to communicate better with others. Sharing what you learn with others will make you more 

productive. 

 
 

Element Title Description 

Active/Individual Cell The active cell is the location of your cursor (sometimes called focus). This is where you 

have clicked on the spreadsheet to place a number or text. If you start typing your characters 

will go into that cell. Notice in the screenshot above cell address D4 is selected. If it was 

your spreadsheet and you started typing your characters would end up in cellD4. 

Dialog box launcher The small down arrow at the bottom right corner of most command groups on the ribbon. 

Expand Formula Bar This down arrow will expand the formula bar to expose more content in the cell that is 

selected.  

Tabs The tabs are the horizontal listing of words across the top of the Excel application. The tabs 

start with Home and continue with Insert, Page Layout, Formulas, Data, Review and View. 

Name box Identifies the cell you are in and acts as a  box if you type an address in the Name box and 

press [ENTER]. 

Ribbon The Ribbon is below the tab names. The more common commands/functions are located 

here. As you click on a tab a different ribbon (group of commands) will appear. 
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Row & Column Headers The row and column headers are used to make changes to row(s) or column(s). If you need to 

change the width, insert, delete or format either; you would right click the header. 

Formula Bar In Excel, you can create a formula in a cell or in the formula bar. The formula bar can be 

expanded to allow you to better see what you are creating. 

Additional Screen Elements 

 
 

Element Title Description 

Task Pane The Task Pane displays normally on the right side of your screen. The Task Pane shows you 

options that support the feature in Excel it goes with.  

Vertical and Horizontal 

Scroll Bars 

The vertical and horizontal bars are located on the right side and on the bottom of the screen. 

Use the scroll box to move up or down, right and left, on larger spreadsheets to navigate to 

other parts of the spreadsheet. 

Tab Scroll buttons The Tab Scroll buttons allow you to move the tabs in your workbook from left to right. 

When you have multiple sheets with long names, some sheets could be out of site/hidden. To 

bring them in to view, you click the arrow heads to move the tabs left or right. 

Sheet tab Sheet tabs can be named and you click an individual sheet tab to make it active.  

New sheet tab When you need to add another sheet to your workbook, click this tab. 

Status Bar The Status bar is located at the bottom of the screen below sheet tabs and the horizontal 

scroll bar. The status bar displays useful information as you work. The word Ready is 

normally displayed on the left side when you first open a spreadsheet. 

Zoom The Zoom bar allows for increasing or decreasing the magnification of your worksheet. This 

is for viewing only and does not affect printing. 

 

About Using ScreenTips, the Ribbon Tabs and Customization Options 

Every tool necessary to create and manipulate spreadsheets in Excel is found using one of the tabs. Many 

of the more commonly used commands are available by clicking a button on the ribbon. You do not need 

to memorize the buttons on a ribbon because each button has a description called a ScreenTip.  A 

ScreenTip pops up when you rest (or hover) your mouse pointer on a button. If the button has a shortcut 

key, that will be displayed within the screen tip. Like screen elements, ScreenTips, menus and 

customization options are also consistent in all the Microsoft Office programs. In this book, you will be 

working with tabs, ribbons, and dialog boxes. The ScreenTips will come in handy as you learn the various 

buttons.  
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Understanding how the tabs are organized will assist you in finding a command that is not found on the 

currently displayed ribbon. The table below lists and defines the types of commands you will find on each 

tab choice.  

Tab Choice Description 

Home 
The Home tab contains common commands to work with your entire workbook. For example, 

New, Open, Save, Save As, Print, Prepare, Send, Publish and Close workbooks. 

Insert 
The Insert tab contains buttons that you click on to insert; a Table, Picture, Clip Art, Charts and 

Header and Footer in your workbook, to name a few. 

Page Layout 
Page Layout help you format your page for printing. Changing font color, effect, margins, 

background and print titles. 

Formulas 
This ribbon list the categories where different Formulas are stored. You can insert a function of 

any type from here. 

Data 
Data tab helps you manage large list of information. You can sort, filter, add subtotals, group and 

delete duplicate rows with the button on this ribbon. 

Review 
The View tab helps support Spell check, Thesaurus, Insert comments and protecting sheets or 

workbooks. 

View 
The View tab give you the ability to change how you view your spreadsheet. You can Zoom in or 

out, remove or add gridlines, even switch between spreadsheets. 

Developer 

The Developer tab will not  appear unless you have entered the Excel Options on the File menu 

and check the box to view this tab. The check box is part of the Popular selection in the group 

labeled ñTop options for working with Excelò. 

Add-Ins 
The Add-Ins tab will not  appear unless you have add-ins. Meaning some other application that 

added a part of their program to Excel. 

Working with ScreenTips 

1. With the Home tab selected, rest your mouse pointer on the  Paste   button. 

The Paste ScreenTip displays. 

 

Notice the shortcut key for this button is displayed with the screen tip. 

2. Rest your mouse pointer on other buttons to view  ScreenTips .  

Working with the Ribbon tabs 

1. Click the tab labeled at  the top, a new ribbon is displayed. 

 

2. Rest/hover your mouse pointer on the  Table   button to view Screen Tip.  

The Table ScreenTip displays. 

Tip : Press the [ALT]  key to 

activate the menu keyboard 

commands.  
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Notice the shortcut key for this button is displayed 

3. If you would like to close the screen tip quickly, press the  ESC key on the 

keyboard. 

The screen tip closes. 

Working with Excel Options  

In the Excel Options dialog box you can change the number of sheets that will be in a new workbook, you 

can change the default format the file will be saved in when you do a normal save, change the  

default font that will be used in future new workbook, and many other standard setting in Microsoft 

Excel. 

1. Click the  File  tab.   

 

2. Click the  Excel Options  button at the bottom. 

 

Your screen should look like this:  
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Notice that here you can change the default font and the number of sheets to include in a new workbook. 

1. Click the  Down arrow   for ñUse this font:ò and select  Times New Roman. 

 

2. Click the  OK button.  

3. Note: The next new spreadsheet you open will have Times New Roman as your 

default font. 

4. Click the message  OK  button to close the Excel message. 

Remember you must close Excel to have the new font take effect. 

Working with Dialog Box Launcher buttons  

 

1. Locate the Font  Dialog box  Launcher button. 

Your screen should look like this: 

 

2. Click the Font Dialog Box Launcher button and the Format Cells dialog box 

appears. 
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Your screen should look like this:  

  

Notice that the Font tab is selected in the dialog box. You will not use any now, but later in the book you 

will use the Format Cells dialog box.  

3. Click the  Cancel   button to close the Format Cells dialog box.  

General Information about Worksheet 

As you look at your spreadsheet, notice that there are letters across the top and number down the side. The 

letters are to identify the columns and the numbers are to identify the rows. One thing that you may not 

have noticed is the large size of your spreadsheet. How large is it you ask? There are 16,384 columns 

across and 1,048,576 rows down. The columns use letters, starting out with A and end with XFD. The 

rows use numbers, starting with 1 and end with 1,048,576.  

A few other interesting facts about Excel ï2013/2016: Limited only by available memory and system 

resources; Column width 255 characters, Row height 409 points, a Cell can hold 32,767 characters, Filter 

drop-down list holds 10,000, Undo levels 100 and nested levels in a formula = 64. 

About Using Excel 2013/2016 Help 

All software programs come with help that you may need in your daily tasks. You can access help one of 

two ways ï either through the Help menu button .  (See screenshot below this paragraph.) Or, you 

can press the F1 function key on your keyboard. F1 is located at the top left of the keyboard. Either way, a 

Microsoft Excel Help window will display on your screen. The help files searches in two ways:  Searching 

Office.com and the Excel help file on your computer. (See second screenshot, the one on the right, to see the 

menu for these two.) 

    question mark in Excel 2013 

text box in Excel 2016  

 

The Search feature gives you the 

ability to search for information or explanations about the topic you would 

like to learn more about. If you have a connection to the internet this feature 

will also search the Microsoft web site for information. Click the down 

arrow to turn off the ñExcel Help from Office.comò. 

Tip : The keyboard 

shortcut key to open this 

dialog box is:  

[CNTRL + Shift + F]   

or 

[CNTRL + 1]  
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The Help dialog is arranged by the Top Categories when it first opens. The top categories are further 

broken down into subcategories. To see the subcategories, just click on the plus sign (+) next to the 

category you would like to open. When you find a topic you are interested in, click the title and you will 

see the help information appear in the help dialog box.  

Working with Help 

1. Press  [ F1 ] on your keyboard. 

Your screen for Excel 2013 on the left for Excel 2016 on the right. 

  

2. Click the plus sign (+) for  Basic use: format, print Excel data. 

  

3. Under the heading, click  Print a worksheet in landscape or portrait orientation. 

 

4. In the center of this screen click  Change the page orientation  under the 

heading What do you want to do? 

 

  

Note: When help appears in 

2013, it should be on top of 

Excel. To make sure that your 

help dialog box does not hide 

when you click on Excel, 

make sure the ñKeep on Topò 

pin is pushed in.  
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Your screen should look like this:  

  

5. Scroll down to number 2 and Read  your instruction to change Orientation. 

Your screen should look like this:  

 

6. Click the  Home  button. 

 

Note: The Microsoft Excel 2013/2016 Help Home button returns you to the beginning state of the Excel 

Help dialog box. 

7. Click the  Close  button in the top right corner of the Help dialog box. 

This will close your help dialog box. 

 

Note: You may need to 

expand the dialog box to read 

the text better. Place your 

mouse on the bottom right 

corner; press and hold the left 

button down and drag out and 

down to make the help dialog 

larger. 
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Close a workbook 

1. Click the  File  tab    

The keyboard shortcut is [CTRL + W]  to close the workbook. 

 

2. Click the  Close   button. 

The keyboard shortcut is [CTRL + W] to close the workbook. 
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Section 1 ï Exercise   

Scenario 

You need to start Excel, control the toolbars and use Help to make adjustments in Excel. 

What to Do: Change worksheet number to 8 for New Workbook, change the 
setting for Menu to animations  

A place to start 

1. Use the Start  button on the taskbar to open Microsoft Excel .  

For an example, refer to page 4. 

2. How do you move the Quick Access Toolbar? 

For an example, refer to page 5. 

3. Change the Font used in Excel to Arial. Remember this is for all future spreadsheets. 

For an example, refer to page 11. 

4. Click the Close  button to close the Customize dialog box. 

5. Open the Excel  options  and change the Sheets in a New Workbook to 3. 

6. Click OK when done. 

7. Press [F1]  to start help and write down the main areas or menu items that help you 

find a topic of interest. 

8. Close the Help  window .  

9. Close the blank workbook. 
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Section 1 ï Review 

You must be able to answer the following questions on your own. As you review the questions below, 

write in your answer below each one.  

 

SKILL CHECKLIST 

1. What steps do you follow to move your Quick Access toolbars? 

2. What are the steps to change the number of worksheets that a new workbook will have 

when Excel first opens? 

3. What is the keyboard command for help? 

4. What are the three ways to search for information in the Help window? 

 

Additional Study  

Use the Microsoft Excel Help features to look up the key words from this section for additional 

information. Example: Options, Customize, and Help 
SKILL HELP KEYWORDS 
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SECTION 2  ö USING EXCEL BASICS FEATURES 

What will I learn in this section? 

Navigating in a spreadsheet 

Selecting cells  

Entering text and numbers 

Save As and Save 

Drag and Drop to move text 

Replacing, Editing and Deleting  

Undo and Redo 

Print Preview 

Printing  
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USING MICROSOFT EXCEL BASICS FEATURES 

Navigation and selection when working with a Worksheet 

First you will open an existing workbook to learn about navigation. As you build your foundation with 

Microsoft Excel, you will learn how to create and modify the cells, columns and rows.  

There are five basic parts to a spreadsheet; columns, rows, column headings, row headings and a cell. The 

cell is the smallest part and has an individual address. The first cell address on your spreadsheet is A1. 

This cell address tells you the location of this cell. Cell A1 is the first cell on the first row in the first 

column. 

The row heading is the gray box to the far left with the number inside. The column heading is the gray box 

at the top of each column where letter(s) identify the column. Our rows are displayed horizontally and 

columns are displayed vertically, these make up the gridlines in our spreadsheet. 

Just a few statistics for you: 

 

A Cell holds: 32,767 characters, 1,024 display in a cell; all 32,767 display in the 

  formula bar. 

A worksheet holds:  1,048,576 rows and 16,384 columns. 

Sheets in workbook:  limited by available memory  

Undo levels:  100 

Zoom range:  10 to 400 percent 

Open an existing workbook 

1. Click the  File   tab. 

  

2. Click the Open menu area click the  Browse  menu. 
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3. Navigate to the location the instructor indicates if needed.   

 

4. Double-click Classwork folder on the desktop. 

The Classwork folder for class will be on the Desktop. 

Your screen should look like this: 

 

5. Double-click Classwork folder on the desktop. 

6. Double-click Navigate workbook to open. 

 

Your screen should look like this: 

 

The following table list, some of the more common keyboard shortcuts. 

KEYBOARD SHORTCUTS 

KEY TO USE ACTION 
[ ALT + PAGE DOWN ] Moves right one screen space 

[ ALT + PAGE UP ] Moves left one screen space 

[ CTRL + . ]   (period) Moves clockwise to the next corner of a selected range 

[ CTRL + BACKSPACE ] Moves your screen to the active cell 

[ CTRL + END ] Moves active cell to last row and column with data 

[ CTRL + HOME ] Moves active cell to address A1 

[ CTRL + LEFT ARROW ] Moves left to end of data or end of sheet 

[ CTRL + PAGE DOWN ] Makes next sheet to the right active  

[ CTRL + PAGE UP ] Makes next sheet to the left active 

[ CTRL + RIGHT ARROW ] Moves right to end of data or end of sheet 

[ CTRL + ALT + LEFT ARROW] With nonadjacent cells or ranges selected, move to the next 
selection to the left 
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[ CTRL + ALT + RIGHT ARROW] With nonadjacent cell or ranges selected, move to the next 
selection to the right 

[ DOWN ARROW ] Moves active cell one row ï down 

[ END  + ARROW] Moves to the end of data in the direction of the arrow  

[ HOME ] Moves active cell to beginning of the row 

[ LEFT ARROW ] Moves active cell one column ï left 

[ PAGE DOWN ] Moves down one screen space 

[ PAGE UP ] Moves up one screen space 

[ RIGHT ARROW ] Moves active cell one column ï right 

[ SHIFT + ENTER] Moves up to cell above current cell 

[ SHIFT + TAB ] Moves active cell left one cell 

[ TAB ] Moves active cell right one cell 

[ UP ARROW ] Moves active cell one row ï up 

Navigate on a spreadsheet  

1. Press  [ CTRL + HOME ].  

Cell A1 is now selected and the active cell. 

2. Press  [ DOWN ARROW ] three times.  

3. Press  [ CTRL + RIGHT ARROW ].  

4. Press  [ HOME ]. 

5. Press  [ ALT + PAGE  DOWN ] three times. 

6. Press [ HOME ]. 

Move between sheets 

1. Press  [ CTRL + PAGE DOWN ]. 

2. Press  [ CTRL + PAGE DOWN ]. 

Sheet 3 is displayed. 

3. Press  [ CTRL + PAGE UP  ] twice. 

Moves you back to sheet1. 

Using the Save As command 

The Save As command allows you to save your existing document with a different name and if you need 

a different location. It is in the backstage area once you click the File tab. The hotkey for Save As is F12. 

  

Tip : To select a column of data, 

click in the first cell with data; 

hold the [CTRL + SHIFT]  and 

tap the down arrow. 

Also to select a column of data; 

hold the Shift, then tap the 

[END], then tap the down arrow . 
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Save a file with a different name 

1. Click the  File tab,  click  Save As and click the 

Browse  menu item to the right.  
Verify that the  Classwork  folder is displayed in the Address bar. 

2. Verify that  Navigate is selected in the File Name box. 

Verify that the Classwork  folder is displayed in the Address bar. 

Your screen should look like this: 

 

3. Type:  Practice Navigate in the File name text box.  

4. Click the  Save button. 
Your original workbook (Navigate) is closed. The new 

workbook (Practice Navigate) is displayed. 

Selecting cells 

The following table identifies a few ways to select an area in an Excel spreadsheet. 

Select Description 

Click cell 
By clicking (using the left mouse button) once while your mouse pointer is over a cell 
you select that single cell. 

Hold [SHIFT] & click 
By clicking on cell A1 (to make it the active cell) and then moving your mouse pointer to 
cell address D5, you press down the [SHIFT] key and click D5. This will select the 
range from A1 to D5 and all cells between. 

Hold [CTRL] & click 
Non-contiguous cell selection. To select more than one group of cells in two or more 
separate areas. 

Press & drag 
By pressing down the left mouse button while over a cell and dragging to a new 
location you select the area that is between the starting point and the ending point. 

[CTRL] & A 
Click inside the table area and press [CTRL] + A. The old keyboard shortcut is:  [CTRL] 
and [SHIFT] together, and press the [EIGHT]. (Not the number keypad.) 

CTRL + ]   (closing bracket) 
Selects Formulas that directly reference the active cell ï if there is not one a message 
will appear.  

Tip : The keyboard shortcut 

key for Save As is [F12]. 

Tip : The keyboard shortcut 

key for Save Asé is [F12]. 

To save is [CTRL + S]  

To save your updates easily.  
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1. Select cell  A4. 
 Click once on the word North. 

2. Hold down the  [ SHIFT  ] key and click  E7. 

The area from A4 to E7 is select. 

Your screen should look like this: 

 

3. While over  B3, press and hold down the left mouse button. Move the mouse to 

cell  E3. 

4. Release the mouse button. 

Your screen should look like this: 

 

5. Click cell  B5.  

This is the same as Clicking on cell B5. 

6. Press  [ CTRL]   + [ A] . 

Your screen should look like this: 

 

Tip : If your mouse has a 

wheel it can also be used to 

navigate the spreadsheet. 

Roll the wheel away from 

you, you scroll up the 

spreadsheet. Roll the wheel 

to you, you scroll down the 

spreadsheet. If you click the 

wheel the movement feature 

is turned on and as you 

move the mouse left, right, 

up or down you scroll in that 

direction. Click the wheel a 

second time to turn it off. 
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Close the workbook 

1. Click the  File tab.  

The keyboard shortcut is [CTRL  + W] or [CTRL  + F4] to close the workbook. 

  

2. Click the  Close   button. 

The keyboard shortcut is  [CTRL  + W] or [CTRL  + F4] to close the workbook. 

  

Creating a Workbook and Modifying a Worksheet 

You create a workbook by opening Excel or while in Excel clicking the, New menu item on the Office 

Button menu. After you have opened a new workbook you will enter text and numbers to build our first 

worksheet. As you type text into a cell you create labels. With a few labels to structure your worksheet you 

can enter data, formulas, and functions to make your worksheet complete. 

As you start to enter data, remember that  [ENTER]  completes the entry and pressing [ESC] cancels it. 

You will work with both keys as you go through the next section. 

Before you start editing a single cell or multiple cells you need to review the mouse pointer. Excel is a 

very powerful application and using the mouse can be a great tool, once you learn its signs. The way the 

mouse communicates with us is by changing its symbol or sign. The table below will help you identify 

each pointerôs sign and its function.  

Pointer Function 

 

The white plus symbol identifies that your mouse is able to select cell(s). If you click 
the left mouse button you will select the cell underneath. If you press and drag the 
mouse you can select more than one cell.   

 

The standard white arrow head mouse pointer with the four black arrows identifies that 
your mouse is able to move cell(s). If you press and hold your left mouse button down 
and drag, when you release the mouse button at the new location the contents of the 
cell you are dragging will be moved to the new location.    

 

The black plus symbol in the lower right corner of a selected cell, identifies that you 
are over the AutoFill handle. You will use the AutoFill handle later in this book. 

 

 

The I-beam symbol identifies that you are over a cell that is in edit mode. Edit mode 
means that you can type, edit and make correction to the contents of the active cell. If 
the cell has a formula or text, you can place the cursor between any characters by 
moving the I-beam to the desired location and click. 
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Creating a New Workbook 

In this section, you learn the basics of creating a workbook and adding information. After you complete 

the text or numbers in an individual cell you will press [ENTER] or [TAB ]. If you press the [ENTER] 

key the active cell moves down one. If you press [TAB ] the active cell moves to the right. Press [Shift  + 

TAB]  the active cell moves to the left. Press [Shift + ENTER] moves you up a row. 

There is one more item that you should be aware of. The Enter and Cancel button located to the right of 

the Name box is a handy button when you have your hand on the mouse. The red X is for Cancel and the 

green check mark is for Enter. The trick is that you cannot see them unless you are in edit mode (typing in 

a cell). Remember that if you are in edit mode most of your menu commands will not work. Clicking on 

the red X is the same as pressing the [ESC] key and clicking on the green check mark is the same as 

pressing [CTRL  + ENTER]. 

The [CTRL  + ENTER] key combination is the same as [ENTER] but the active cell dose not move. 

 

Adding labels 

Next you will create a new workbook to begin filling in information on your spreadsheet. 

1. Click the  File tab and click  New. 

Your screen should look like this: 

 

2. Double-click the  Blank workbook   template to create a new workbook. 

 

3. Type:  First  Quarter Sales  and press  [ ENTER ] three times. 
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4. Type:  Widget 201  and press  [ ENTER ]. 

5. Type:  Widget 202  and press  [ ENTER ]. 

6. Type:  Widget 203  and press  [ ENTER ]. 

7. Type:  Widget 204  and press  [ ENTER ]. 

Your screen should look like this: 

 

8. Click cell  B3. 

9. Type:  Jan  and press  [ TAB ]. 

10. Type:  Feb and press  [ TAB ]. 

11. Type:  Mar and press  [ TAB ]. 

12. Type:  Total s  and press  [ TAB ]. 

Your screen should look like this: 

 

Adding numbers 

1. Click the cell  B4. 

2. Type:  231  and press  [ TAB ]. 

3. Type:  243  and press  [ TAB ]. 

4. Type:  252  and press  [ ENTER ]. 

5. Type:  523  and press  [ TAB ]. 

6. Type:  487  and press  [ TAB ]. 

7. Type:  544  and press  [ ENTER ]. 

8. Type:  345  and press  [ TAB ]. 

9. Type:  367  and press  [ TAB ]. 
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10. Type:  398  and press  [ ENTER ]. 

11. Type:  439  and press  [ TAB ]. 

12. Type:  401  and press  [ TAB ]. 

13. Type:  458  and press  [ ENTER ]. 

Your screen should look like this: 

 

Save the workbook 

1. Click the  Save  button on the Quick Access toolbar. 

   

2. Verify that the  Classwork  folder is selected in the address bar, and  

Type:  First Quarter Sales . 

Your screen should look like this: 

 

3. Click the  Save   button. 

Your new workbook has been saved. 

Your screen should look like this: 

 

Tip : The keyboard shortcut 

key for Save Asé is: [F12] 

The keyboard shortcut for 

Save is: [CTRL  + S] 
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Moving text on a spreadsheet 

You move cell content around on your spreadsheet just by selecting it and dragging the cell contents with 

the mouse. In the next few steps you will learn to move and copy information around on your spreadsheet. 

1. Click cell  A1. 

2. Place your mouse pointer on the bottom border  of cell A1. 
Notice the four way symbol that appears on the tip of your mouse pointer. 

 

 

3. Press the left mouse button down and hold, move your mouse pointer to  C1. 

4. Release   the mouse button. 

The text ñFirst Quarter Salesò has been moved to cell C1. 

Move and copy text 

To move text or numbers on your spreadsheet and copy at the same time, you need to add the [CTRL ] key 

to the mouse action. It will take two hands to complete this action. 

1. Click cell  E3. 

2. Place your mouse pointer on the  bottom border  of cell  E3. 

You now have a  four way pointer added to your mouse pointer. 

3. Hold down  [ CTRL ] key with one hand. 

The pointer now has a  plus symbol next to it not the four way pointer. 

 

4. Press the  left  mouse button down and hold, move your mouse pointer to  A8. 

5. Release the mouse button and then the  [ CTRL ] key. 

Your screen should look like this: 

 

6. Click the  Save  button or press  [ CTRL +  S ] to save. 
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Editing and Deleting text 

As you work on your spreadsheet you will need to make changes. When you select a cell you can type 

over the current text or numbers, delete the contents or double click the cell to edit. In the next few steps 

you will do all three. First you will replace the heading by typing over the cell content. Edit cell A8 by 

changing the text in the cell and delete the contents of a cell using the right mouse button. 

On the Home tab in the Editing group you have the Clear feature. This can be used to 

Clear Content as well as items. The Clear Content can also be accessed by pressing the 

right mouse button to view a menu and selecting Clear Content. 

1. Click cell  C1 and press [ F2] . 

2. Press the [Space bar] and type:  Report 

3. Press  [ ENTER ]. 

4. Right-click cell  E3 and select  Clear Contents  from the shortcut menu. 

Your screen should look like this: 

 

Undo and Redo 

In Excel you can undo 100 edits. As you need to correct a last minute change or add something back in 

that you have removed this can be done with a few steps. Your Undo and Redo buttons are on your Quick 

Access Toolbar.  

 

1. Click the  Undo button.  

The text Total is placed back into cell E3. 

 

2. Click the  Redo button. 

 

3. Click the Undo button to place Totals back in cell E3. 
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Print Preview and Printing a workbook 

After you save your workbook, you may need a printed copy. With the Print feature, you can print one or 

more copies. You can even specify Active sheet(s), Selection, or Entire workbook to print. If all you need 

to print is a single copy of your workbook, click the Print button on the Standard toolbar. If you choose the 

File | Print command from the menu bar, you can specify Active sheet(s), Selection, Entire workbook, or 

print multiple copies of any of the three. The Print Preview button shows you a simulated print of the 

selected item. This is a good way to save paper. 

Print Preview the workbook 

1. Click the  File tab.   

 

2. Click Print and a Print Preview   of your documents appears within the 

print dialog box. 

The keyboard shortcut is [CTRL +P]  to open the print dialog box. 

Your screen should look like this: 

 
 

3. Press the  [ESC]  key to close the print dialog box.  

4. Press the  [CTRL + P ]   keyboard shortcut to re-open the print dialog box. 

Notice under the Settings title you have Print Active Sheets. When selected you have four  

choices:  Print Active Sheets, Print Entire Workbook, Print Selection and Ignore Print Area.  

5. Click the  down arrow for Print Active Sheets  button. 

 

 

6. Select from the drop down,  Ignore Print Area .   

7. No, you will not print. Press [E SC]  key to return to your workbook. 
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Close the workbook 

1. Press [CTRL + W ]  to close the workbook.   

The keyboard shortcut is [CTRL + F4] to close the workbook also. 

2. If prompted to save the workbook, click 

the  Donôt Save  button. 
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Section 2 ï Exercise   

Scenario 

Your manager has given you the task of navigating a new spreadsheet and making minor 

changes. 

What To Do: Add, Copy and Edit 

A place to start 

1. Use the  Start button on the taskbar to open  Microsoft Excel .  

For an example, refer to page 4. 

2. Open the file,  Section 2 Exercise   file. 

For an example, refer to page 19. 

3. Select (highlight) the complete table from B4 to G8. 

For an example, refer to page 22. 

4. In cell H4 add the label  Totals . 

For an example, refer to page 25. 

5. Copy the label  Totals   in cell H4 to cell B9. 

For an example, refer to page 28. 

6. Change the label in cell B4 to  Sales Staff . 

For an example, refer to page 29. 

7. Save and close all open files. 
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Section 2 ï Review 

You must be able to answer the following questions on your own. As you review the questions below, 

write in your answer below each one.  

 

SKILL CHECKLIST 

1. What is the keyboard shortcut to return the active cell to A1? 

2. How do you save your workbook with new/different name? 

3. Name one way to select an area on your spreadsheet? 

4. How do you move the contents of a cell from one location to another? 

5. Where is the Print Preview menu? 

Additional Study  

Use the Microsoft Excel Help features to look up the key words from this section for additional 

information. Example: file name (rename a file), Select (select data or cells) and Print preview 

(Print preview commands) 
SKILL HELP KEYWORDS 
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SECTION 3  ö CREATING FORMULAS 

What will I learn in this section? 

Creating Formulas 

Mastering AutoFill  

Moving and Copying Formulas 
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CREATING FORMULAS 

Creating and Using Formulas 

In this section, you learn how to create formulas. Formulas are the way that you take advantage 

of the power and fixability of an electronic spreadsheet. When you create a formula the cell 

address(es) are always used to complete the mathematical calculation. By using the cell 

address(es) and not the actual number(s) your formula remains correct no matter how many 

times the numbers may change. When you create a formula, your numbers can be calculated in 

any fashion you like.  

 

A formula in Excel always start with Equal symbol [ = ], and cell addresses are normally 

separated by math operators; but other characters can be used to accomplish the desired math 

operation. Text as well as numbers can be manipulated using formulas.  

 

Simple formula example:  = B2 + C2 + D2  

This formula would add the contents of the three cells together, and appear in the cell where the 

formula is written. All formulas in Excel are read from Left to Right. The below table list the 

math operators that can be used in creating a formula. You may have learn in school the 

following: ñPlease Excuse My Dear Aunt Sallyò This is a way to remember order of 

Precedence. 

 
Operators Action Order of Precedence 

( ) Parenthesis encases an operation for control First  

^ Exponent Second 

*  Multiplication Third or 

/ Division Third  

+ Addition  Fourth or 

 Subtraction Fourth 

 

Simple example: 

 

20 * 4 + 10 = 80 + 10 = 90 Here we have no parenthesis. 

20 * (4 + 10) = 20 * 14 = 280 Here we are using parenthesis. 

 

Take a look at this formula to follow the order of operation. If you just type it in to the cell the 

answer would be: 

 

= 200+100*10% the answer would be  210 

We know that 10% of 300 is 30! So what happen here? 

 

Excel used the order of precedents to do the math. Multiplying 100 time 10% which give the 

answer of 10. Then Excel took the 10 and added the 200 to complete the formula with an 

answer of 210. Which we know is incorrect. 

The correct way to type the formula would be:  =(200+100) * 10%  

The answer would then be 30. 
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Needless to say, putting thing in the right order is very important. Remember the parentheses 

will be done first when they are included and your math teacherôs rule: ñPlease Excuse My 

Dear Aunt Sallyò.    

 

Mastering AutoFill 

In Microsoft Excel, AutoFill is a feature that allows the user to extend a series of numbers, 

dates, or even text to the necessary range of cells. This little option gives you plenty of 

possibilities. See table below for lots of examples. 

 

Double Needed Initial selection  Extended series  

Yes 1, 2, 3 4, 5, 6,... 

 9:00 10:00, 11:00, 12:00,... 

 Mon Tue, Wed, Thu,... 

 Monday Tuesday, Wednesday, Thursday,... 

 Jan Feb, Mar, Apr,... 

Yes Jan, Apr Jul, Oct, Jan,... 

 Jan-17 Feb-17, Mar-мтΣ ΧΣ Wŀƴ-08,... 

Yes 15-Jan, 15-Apr 15-Jul, 15-Oct,... 

Yes 2007, 2008 2009, 2010, 2011,... 

 1-Jan, 1-Mar 1-May, 1-Jul, 1-Sep,... 

 Qtr3 (or Q3 or Quarter3) Qtr4, Qtr1, Qtr2,... 

Yes - # increments  text1, textA text2, textA, text3, textA,... 

 1st Period 2nd Period, 3rd Period,... 

 Product 1 Product 2, Product 3,... 

Yes - # increments Widget 201, Widget 202 ²ƛŘƎŜǘ нлоΣ ²ƛŘƎŜǘ нлпΣ ²ƛŘƎŜǘ нлрΣΧ 

 

Open workbook to entering a formula 

In the next file, you will create a few basic formulas to add your columns. 

1. Click the  File   tab, Open menu and Browser menu. 

   

2. Verify  Classwork folder is listed in the  Address bar.  

3. Select the  Quarterlyexpense  workbook and click  Open. 
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4. Press the  [ F12 ] key. 

The Save As shortcut key. 

5. Verify that the  Classwork  folder is selected in the  Address bar . 

6. In the File name text box, type:  Practice Quarterlyexpense  

7. Press  [ ENTER ] or click the  Save  button. 

Entering a formula 

1. Click in cell  B8. 

2. Type:  =B4+B5+B6+B7 and press   

[ CTRL +  ENTER ]. 

3. Click in cell  C8. 

4. Type:  =C4+C5+C6+C7 and press  [CTRL +  ENTER ]. 

Your screen should look like this: 

 

More about AutoFill  

As you work on a spreadsheet you can speed up the process by using the AutoFill  handle. You can use 

this fill handle to fill in a series, repeat values or copy formulas. The fill handle is a small green square in 

the lower-right corner of the selected cell or range. To select the AutoFill  handle, you place the mouse 

over the green box, press the left mouse button down and drag to the new location. You will know your 

mouse is over the green box when it changes into a black plus. 

 

1. Using the selected cell C8, place the mouse pointer over the AutoFill handle. 

When it changes to a  black plus ,  (+) press and drag your mouse to cell  D8. 

 

Tip : By pressing  

[CTRL  + ENTER] 

you stay on the cell 

that you are typing in. 

It helps you confirm 

your formula before 

moving off the cell. 
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2. Release   the mouse button. 

Your screen should look like this: 

  

The small icon that you see after you release the mouse is called the AutoFill Options button.  

Creating an additional formula 

1. Select cell  B17. 

2. Type:  =B13+B14+B15+B16   and press  [ CTRL  +   ENTER ]. 

3. Place the mouse over the  green  box .  

 

4. When it changes to a black plus,  (+) press and drag your mouse to cell  D17. 

5. Release   the mouse button. 

Your screen should look like this: 

 

Notice the AutoFill Option button that appeared once you released the mosuse. 

Depending on what you have used the AutoFill handle for, you will get different menus.  

If you click now you will get the menu shown below. 
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Creating a new formula to show profits earned for each month. 

1. Click in cell  B19.  

2. Type:  =B8- B17  Notice the color coding that appears on your spreadsheet. 

3. Press  [ CTRL  +  ENTER ]. 

Your screen should look like this: 

 

4. Place the mouse pointer over the AutoFill handle, when the  black plus  

appears; press down and drag to D19. 

Edit data using the Formula bar 

1. Select cell  C1. 

2. Click after the word  ñEastern ò in the Formula bar. 

3. Type:  ós   

4. Click  [ SPACEBAR ] and type:  First  click  [ SPACEBAR ] 

5. Click after the word ñQuarterly ò and  [ BACKSPACE ] twice. 

6. Press  [ CTRL  +  ENTER ]. 

Your screen should look like this: 

 

7. Press  [ F2 ]. The [F2] key is the keyboard shortcut for edit. 

8. Press  [ HOME ]  

9. Press  [ DELETE ] until you remove all of the word ñEasternôsò. 

10. Type:  Regional  and press [ SPACEBAR ] 

11. Press  [ CTRL  +  ENTER ]. 

Your screen should look like this: 

 

12. Click the  Save  button or press  [ CTRL  +  S ] to save. 
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Moving Cell Content 

You can use the mouse to drag and drop the content of a cell to a new location. The edit menu can also 

be used to copy, cut and paste. In the following step, you will move the word ñSalesò. 

1. Click on cell  A17. 

2. Place the point of the mouse pointer on the  bottom  border. 

 

3. Press the  [ CTRL ]  key down and hold with one hand. 

4. Press the left mouse button down with the other hand and drag the mouse to cell  

E3. 

5. Release  mouse  and then the  [ CTRL ]. 

Your screen should look like this: 

 

Copying Cell Content  

You can copy the contents of any cell using the same technique by adding the [CTRL] key to the process. 

Press the [CTRL] key down first and then drag to the cell address where a copy is needed. The important 

part is to release the mouse button before you release the [CTRL]. In the following step you will copy the 

word ñTotalsò. 

1. Place the point of the mouse pointer on the  bottom border of cell  E3. 

2. Hold down the  [ CTRL ] key with the other hand and drag the mouse to cell  E12. 

3. Release  [ CTRL ] and then the  mouse. 
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Your screen should look like this: 

 

Copying a formula to a new cell 

1. Click on cell  E4. 

2. Type:  =B4+C4+D4 and press  [ CTRL  +  ENTER ]. 

3. Right click E4 and select  Copy from the shortcut menu. 

 

4. Select  E5 to  E8 and right click the highlight. 

 

5. Under the Paste Options menu, click the first clipboard to  Paste . 

 

Your screen should look like this: 

 

6. Click the  Save  button or press  [ CTRL  +  S ] to save. 
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Relative Reference 

A relative cell reference is one where the location is relative to the originating cell that contains 

the formula. When you copy, or drag the AutoFill handle down a column Excel changes the 

original formula cell addresses by adding a number. 

For example:  

 

 

 

 

 

 

 

 

 

As you see here B4+C4+D4 changed to B5+C5+D5 and B6+C6+D6 etc. This change in cell 

addresses is called a Relative Reference.   

 

There will be more on relative and absolute references in the next section. 

1. To see your formulas on a spreadsheet you can click the Formulas tab and in the 

Formula Auditing group, click Show Formulas button. Click the button again to 

hide the formulas.  

2. Close all open files. 

Here in the example to the left the original 

formula was on row four .  

 

When you copy down to the next row Excel 

increments the number(s) in the cell by one. 
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Section 3 ï Exercise   

Scenario 

You have just been given a new workbook file that needs a few formulas added. 

What To Do: Add the formulas where needed 

A place to start 

1. Use the Start button on the taskbar to open Microsoft Excel.  

For an example, refer to page 4. 

2. Create a formula in E4 to total B4 to D4 so the answer is in E4. 

For an example, refer to page 36. 

3. Add all the numbers together from B4 to B7 so the answer is in B8. 

For an example, refer to page 36. 

4. Using the AutoFill  handle complete the totals from B8 to D8. 

For an example, refer to page 37. 

5. Copy A8 to E3. 

For an example, refer to page 40. 

6. Copy the formula in formula in E4 to cells E5 to E8 using the copy ï paste method. 

For an example, refer to page 41. 

7. Save and close all open files. 
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Section 3 ï Review 

You must be able to answer the following questions on your own. As you review the questions below, 

write in your answer below each one.  

 

SKILL CHECKLIST 

1. What is the first character for all formulas? 

2. How do you use the AutoFill handle to copy formulas? 

3. There are three ways of editing a formula on a spreadsheet, name two. 

4. How do you copy content or a formula to a new cell? 

 

Additional Study  

Use the Microsoft Excel Help features to look up the key words from this section for additional 

information. Example: Navigate, Save, and Editing. 
SKILL HELP KEYWORDS 
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SECTION 4  ö FUNCTIONS  

What will I learn in this section? 

Using Functions 

Relative and Absolute reference 

Creating Functions in different ways 
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FUNCTIONS 

Creating and Using Functions 

In the next few steps, you learn to use functions. By using functions, you can quickly perform a set of 

predefined calculations. Many common formulas have been summarized into functions. In a function, you 

do not specify math operations or order of precedence. You only specify the function command, and then 

enter the cells referenced in the argument of the function. 

A function is a built-in formula; a named and stored procedure that performs a specific operation and 

returns a value using a few letter to identify a type of function to be performed in Excel. A set of 

parentheses follow the letters to place your range or item into. An argument consists of numbers, range 

references, text, logical values, arrays, or error values. 

The most common function used in todayôs spreadsheet is the SUM function. This function is used to add 

numbers together and has a button on the tool bar to help you create it. When a function is used it normally 

includes an argument. In the two functions you will use a range of cells for our argument. 

A range of cells is from one cell address to another. Example:  (B16:D16) This range could be used in a 

cell, along with the function SUM to calculate a total.  Example: =SUM(B16:D16) 

Functions can be upper case or lower case. There are over 500 functions in Excel, in this training book, 

however, you only create two but this will provide a foundation for you to understand how many of the 

other functions are utilized. 

Creating a Function 

1. Click the  File   tab, Open menu and Browser menu. 

   

2. Verify  Classwork folder is listed in the  Address bar.  

 

3. Select the  Functions  workbook and click  Open. 

4. Press the [ F12 ] key. 

This is the Save As shortcut key. 

5. Verify that the  Classwork  folder is selected in the Save in drop down list. 

6. In the File name text box, type:  Practice Function s  



  Excel 2013/2016 Step One 

  47 

7. Press  [ ENTER ] or  click the  Save  button. 

Working with AutoSum 

Select the cell or cells where you want the SUM function to appear. When you first click the AutoSum 

button, a marquee will appear selecting a range. If the selected range is correct, click the AutoSum button 

again. If the suggested range of cells is incorrect, then use the mouse to select the correct range of cells, 

and click the AutoSum button. 

Use AutoSum to calculate a total 

1. Select cell  E4. 

2. Click the  AutoSum  button on the Home tab, in the Editing group. 

3. Click the  AutoSum.   

  

Your screen should look like this: 

 

4. Click the  AutoSum a second time. 

This completes the formula. 

Your screen should look like this: 

 

5. Select cells  E5:E 8, and click the  AutoSum  button. 

Your screen should look like this: 

 

6. Select cells  E13:E1 7, and click the  AutoSum  button. 

Tip : By pressing  

[ALT + = ]   ( equal sign ).  

The AutoSum formula is created. 

After pressing the above key 

combination press: 

[CTRL + ENTER] to complete the 

AutoSum formula.  
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Your screen should look like this: 

 

7. Click the  Save button or press  [ CTRL  +  S ] to save. 

Understanding Relative Reference 

You have just completed a relative cell reference step. A relative reference is when you copy a formula 

from one cell to another. If a cell has a formula of   =B4+C4+D4 and you use AutoFill or copy the 

formula down one row, Excel changes the formula to  =B5+C5+D5.  Notice that the only item that 

changed in the formula was the number. When you copy down over rows Excel will increase the 

number in your formula by one for each row you pass. This way the formula is away correct for the new 

row. 

 

 

 

 

 

 

When you copy over columns; copying from left to right over columns, Excel will change the letters. If 

a cell has a formula of  =SUM(B4:B7)  and you copy the formula across one column to another, Excel 

changes the formula to  =SUM(C4:C7).  Notice that the only item that changed in the formula was the 

letter. When you copy from left to right to the next column, Excel will increase the letter by one for each 

column you pass. 

Example:  A becomes B, B becomes C, C becomes D, etc. 

 

Comparing Relative Formulas  

1. Select cell  E4.  

2. Look at the  Formula Bar above. 

  

Here in the example to the left the original 

formula was on row four .  

 

When you copy down to the next row Excel 

increments the number(s) in the cell by one. 


















































































